Register your product and get support at

www.philips.com/welcome

DS3880W/10

SV Anvandarhandbok

PHILIPS






Innehallsforteckning

3

o

>

1 Viktigt! 4 2
Sakerhet 4
Obs! 5
2 Underhallningssystem 7
Introduktion 7
Férpackningens innehdll 7
Dessutom behéver du 7
Oversikt éver huvudenheten 8
Borja anvinda AirPlay 9
3 Innan du borjar 10
Ansluta strdmmen 10
Sl pa/av DS3880W 10

4 Anslut till ditt Wi-Fi-natverk for AirPlay 11
Scenario 1: Ansluta till en WPS-router 1"
Scenario 2: Ansluta till en icke-WPS-router 12

5 Uppspelning 18
Strémma ljud fran iTunes-musikbiblioteket till
DS3880W 18
Kontrollera uppspelning 19
Anvinda avancerade ljudinstiliningar 19
Spela upp/ladda din iPod/iPhone/iPad via USB-
uttaget 20
Spela upp frdn en extern enhet 20

6 Uppdatera fast programvara 22
Ladda ned uppdateringsfilen 22
Uppdatera fran konfigurationssidan 22

7  Produktinformation 24
Specifikationer 24

8 Felsokning 25

Ssv. 3



1 Viktigt!

Sakerhet

Information for Europa:

Lar dig de har sakerhetssymbolerna

CAUTION
RISK OF ELECTRIC SHOCK
DO NOT OPEN

(CAUTION: TO REDUCE THE RISK OF ELECTRIC SHOCK, DO NOT
REMOVE COVER (OR BACK). NO USER-SERVICEABLE PARTS
INSIDE. REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

A A

Utropstecknet betyder att det finns funktioner
som du bor ldsa mer om i den handbok

som medfdljer, for att undvika problem vid
anvandning och underhdll.

Blixtsymbolen anger att det finns oisolerade
komponenter i produkten som kan ge en
elektrisk stot.

For att minska risken for brand och elektriska
stotar bor du inte utsétta apparaten for regn
eller fukt och du bor inte heller placera karl
med vatten, exempelvis blomvaser, ovanpa
produkten.

Las de har instruktionerna.
Behall de har instruktionerna.
Las och ta till dig varningstexten.
Folj samtliga instruktioner.

Anvand inte produkten i narheten av
vatten.

Rengor endast med torr trasa.

O O®OEO

Blockera inte ventilationsoppningar.
Installera apparaten i enlighet med
tillverkarens instruktioner.

o~

N%

Ta inte bort produktens hdlje.

@ Utsitt inte produkten for droppande/
stankande vatten, regn eller hog fuktighet.

Skydda produkten mot direkt solljus,
oppna lagor och varme.

@ Installera den inte i ndrheten av nagon
varmekalla, som element, varmluftsintag,
spis eller annan elektrisk utrustning
(inklusive forstarkare).

@ Placera inte nagon annan elektrisk
utrustning pa produkten.

@ Placera inga farliga foremal pa enheten
(t.ex. foremal som innehaller vitska, eller
levande ljus).

Produkten kan inkludera batterier.
Se sakerhetsinstruktionerna och
instruktionerna for kassering av batterier
i den har anvandarhandboken.

@ Om nitkontakten eller ett kontaktdon
anvinds som frankopplingsenhet ska den
vara litt att komma at.

1N Varning

¢ Ta aldrig bort holjet fran apparaten.

* Smorj aldrig ndgon del av apparaten.

* Placera aldrig apparaten ovanpd nagon annan elektrisk
utrustning.

* Skydda apparaten mot direkt solljus, &ppna ldgor och
varme.

¢ Se till att ndtsladden, kontakten och adaptern alltid &r
enkelt tillgéngliga sa att du kan koppla bort apparaten
fran eluttaget.




1N Varning

* For att undvika skador ska du aldrig stoppa fingrarna i
baskanalen (1) eller handerna i aluminiumringen (2).

Risk for Gverhettning! Installera inte apparaten

i ett trangt utrymme Ldmna alltid ett utrymme
pa minst 10 cm runt apparaten for ventilation.
Se till att gardiner och andra féremal inte tacker
apparatens ventilationshal.

Natsakring

Den hér informationen giller bara produkter
med en natkontakt fran Storbritannien.

Den hdr produkten har en godkand gjuten
kontakt. Om du byter sdkringen ska du anvdanda
en med:

*  Klassificering synlig pa kontakten,

*  den ska vara BS 1362-godkand och

*  ha ASTA-godkdnnandemdrke.

Kontakta aterforséljaren om du dr osdker pa
vilken typ av sdkring du ska anvdnda.

Varning! For att uppfylla EMC-direktivet
(2004/108/EG) far ndtkontakten inte skiljas fran
ndtsladden.

Obs!

q

Anvandning av den hdr produkten
dverensstammer med EU:s forordningar om
radiostérningar.

C€ 0560 (1) RaTTE Directive 1999I5/EC

BG VRO vV [BE VIIT /[ /]IS V/][SE /|
bk VIES V]cz /INL /[AT /v V/[sK /|
FR VUK VIFI /IPT /ey /T /[Pl V|
HU V/INO VIGR /sl VEE V/
T /WU VI]E V/ V/IbE V/

Enheten kan anvdndas i EU utan begrdnsningar
inomhus, men kan inte anvandas utomhus i
Frankrike pa hela frekvensbandet tills nagot
annat tillkdnnages
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Den hdr produkten uppfyller kraven i direktivet
1999/5/EG.

Andringar

Foérdndringar som inte godkants av tillverkaren
kan upphdva anvdndarens behorighet att
anvdnda den hédr enheten.

&

Produkten ar utvecklad och tillverkad av
hogkvalitativa material och komponenter som
bade kan atervinnas och dteranvandas.

)¢

Nar den hdr symbolen med en &verkryssad
papperskorg visas pa produkten innebdr det att
produkten omfattas av det europeiska direktivet
2002/96/EG.

Ta reda pa var du kan hitta ndrmaste
atervinningsstation for elektriska och
elektroniska produkter:

Folj den lokala lagstiftningen och sldng inte dina
gamla produkter i det vanliga hushallsavfallet.
Genom att kassera dina gamla produkter pa
ratt sitt kan du bidra till att minska eventuella
negativa effekter pa milj¢ och hdlsa.

)¢

Din produkt innehdller batterier som omfattas
av EU-direktiv 2006/66/EC, som inte far
kasseras som vanliga hushallssopor.Ta reda

pa vilka lokala regler som giller for separat
insamling av batterier eftersom korrekt
kassering bidrar till att férhindra negativ
paverkan pa miljé och hdlsa.

Ssv. 5



Information om batterianvandning:

n Var forsiktig

¢ Risk for ldckage: Anvand endast den angivna
batteritypen. Blanda inte nya och anvédnda batterier.
Blanda inte batterier av olika marken. Kontrollera
att polerna hamnar at rétt hall. Ta bort batterier ur
produkter som inte anvands under en langre tid.
Forvara batterier pa en torr plats.

¢ Risk for personskada: Anvand handskar nar du hanterar
lickande batterier. Forvara batterier utom réckhall for
barn och husdjur:

* Risk for explosion: Kortslut inte batterier: Utsitt inte
batterier for stark hetta. Slang inte batterier i eld.
Skada inte och ta inte isdr batterier: Ladda inte ej
laddningsbara batterier.

Ta alitid med dig produkten till en yrkesman for
att ta bort det inbyggda batteriet.

Miljoinformation

Allt onddigt férpackningsmaterial har tagits
bort.Vi har f6rsokt géra paketeringen latt att
dela upp i tre olika material: kartong (ladan),
polystyrenskum (buffert) och polyeten (pasan
skyddande skumskiva).

Systemet bestar av material som kan dtervinnas
och ateranvdndas om det monteras isdr av ett
specialiserat foretag. Folj de lokala foreskrifterna
for kassering av férpackningsmaterial, anvanda
batterier och gammal utrustning.

-
Made for

\iPod OiPhone |_]iPad
[al

AirPlay

“Made for iPod”,"Made for iPhone” och “Made
for iPad” betyder att ett elektroniskt tillbehor
har tagits fram sarskilt for iPod, iPhone eller
iPad, och att utvecklaren har certifierat det for
att uppfylla Apple-standard. Apple ansvarar

inte f&r den hdr enhetens funktion eller dess
uppfyllande av standarder f6r sakerhet och
anvdndning. Observera att anvandningen av det
har tillbehdret med iPod, iPhone eller iPad kan
paverka den tradlésa kapaciteten.

AirPlay, iPod och iPhone dr varumdrken som
tillhor Apple Inc., registrerat i USA. och andra
lander. iPad &r ett varumarke som tillhor Apple
Inc.

Symbol for klass ll-utrustning:

ol

Dubbelisolerad KLASS ll-apparat utan
skyddande jordanslutning.

E Kommentar

* Typplattan sitter pa baksidan av apparaten.




2 Underhallnings-
system

Gratulerar till din nya produkt och vélkommen
till Philips! Genom att registrera din produkt pa
www.philips.com/welcome kan du dra nytta av
Philips support.

Om du kontaktar Phillips behéver du ange
modell- och serienumret till apparaten. Modell-
och serienumret finns pa apparatens undersida.
Skriv numren har:

Modellnummer

Serienr

Introduktion

Med Apple AirPlay-tekniken kan du spela upp
ditt iTunes-bibliotek fran din Mac, PC, iPhone,
iPod touch eller iPad med alla AirPlay-aktiverade
enheter (till exempel din DS3880W) som ar
anslutna till Wi-Fi-natverket.

Med en AirPlay-aktiverad enhet (till exempel din
DS3880W) kan du:
e stromma ljud fran iTunes-
musikbiblioteket till valfritt rum hemma
* vidlja vilka AirPlay-aktiverade enheter
du vill spela upp musik pa (om du har
fler 4n en sadan enhet hemma)
*  strémma ljud till flera AirPlay-aktiverade
enheter samtidigt (endast fran iTunes-
musikbiblioteket pa din PC/Mac)

5

* Information om fler Philips AirPlay-aktiverade enheter
finns pd www.philips.com/welcome.

Med DS3880WV kan du adven:
* ladda din iPod/iPhone/iPad via USB-
uttaget med hjdlp av en Apple USB-
kabel (medfdljer inte).

*  spela upp ditt iTunes-musikbibliotek pa
en iPod/iPhone/iPad via USB-uttaget
direkt medan du laddar.

*  spela upp musik fran andra
ljudenheter via MP3-LINK-uttaget.

Forpackningens innehall

Kontrollera och identifiera innehallet i
forpackningen:

»  DS3880W huvudenhet (med inbyggd

Wi-Fi-modul)

* 1 x ndtadapter

* 1 MP3 link-kabel

*  Laddningsstall

*  Anvéandarhandbok (pa CD-ROM)

*  Snabbstartguide

Dessutom behover du

For att stromma ljud tradlost med AirPlay
behoéver du:
*  EnWi-Fi-certifierad router
*  Envard for iTunes-musikbiblioteket,
till exempel en iPod touch/iPhone/
iPad med iOS 4.3 (eller senare) eller
en PC/Mac med Wi-Fi-funktioner och
iTunes 10 (eller senare)
Din DS3880VV maste vara ansluten till samma

lokala natverk som iTunes-vardenheten via Wi-
Fi-routern.

Lista med kompatibla iTunes-

vardenheter for AirPlay

Nar det géller AirPlay ar DS3880W kompatibel

med:

*  en Wi-Fi-aktiverad PC/Mac med iTunes 10
(eller senare), och

»  foljande modeller av iPod/iPhone/iPad med
iOS 4.3 (eller senare):

e iPad2

e iPad

e iPhone 4

*  iPhone 3GS

*  iPod touch (2:a, 3¢, 4:e generationen)

N% 7
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Oversikt éver huvudenheten

®

® ©

(D Strémindikator (7) WI-FI SETUP knapp/indikator
@ & *  Anslut enheten till ett Wi-Fi-nétverk.
- Sla pa/av DS3880W. *  Visa enhetens Wi-Fi-anslutningsstatus.

G »n MP3-LINK

*  Anslut en extern ljudspelare med hjélp
av den medféljande MP3 link-kabeln.

@ +- (® DCIN

*  Justera volymen. .
. *  Anslut ndtadaptern.
e (Hall bada knapparna intryckta) nSit hatacaptem

aterstélla DS3880W.

@ Stativ

(6) USB o<
*  Anslut en iPod/iPhone/iPad med hjdlp
av en Apple USB-kabel (medféljer
inte).

*  Starta eller pausa skivuppspelning.

8 SV



Borja anvanda AirPlay

For att borja anvdanda AirPlay maste du:

1

Uppgradera iPod touch/iPhone/iPad till
den senaste iOS-versionen (I0S 4.3 eller
senare).

*  Ellerinstallera den senaste versionen
av iTunes (iTunes 10 eller senare) pa
din PC/MAC.

Anslut strdmmen till DS3880W och starta

(se 'Innan du bdrjar' pa sidan 10).

Anslut DS3880W till ditt befintliga Wi-Fi-

natverk.

Se till att din iPod touch/iPhone/iPad eller
PC/MAC ocksa ansluts till samma Wi-Fi-
natverk.

N%
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3 Innan du borjar

Folj alltid anvisningarna i det hdr kapitlet i ratt
folid.

Ansluta strommen

n Var forsiktig

* Risk for produktskadal Kontrollera att ndtspanningen
motsvarar den spanning som &r tryckt pa undersidan
av enheten.

* Risk for elektriska stotar! Nar du kopplar bort
ndtadaptern ska du alltid dra ut kontakten ur uttaget.
Dra aldrig i sladden.

¢ Setill att alla andra anslutningar har gjorts innan du
ansluter natadaptern.

DS3880WV har ett inbyggt batteri, vilket gor
att du kan njuta av musik ndr du dr pa sprang.
Ladda det inbyggda batteriet helt innan
anvandning.

1 Docka DS3880W-huvudenheten i
laddningsstillet.
2 Anslut ntsladden til
*  DC IN-uttaget pa laddningsstéllets
baksida.
*  vdagguttaget.

10 sV
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* Om det inbyggda batteriet dr fulladdat lyser

stromindikatorn pa enhetens framsida med ett fast blatt
sken efter anslutning till ndtstrdmmen; om det inbyggda
batteriet inte ir fulladdat blinkar strémindikatorn blatt;
om batteriet dr tomt lyser strémindikatorn med ett fast
rétt sken.

Sla pa/av DS3880W

1
2

Starta enheten genom att trycka pa O pa
ovansidan.

Vinta tills enheten har startat upp.
> Uppstarten tar ungefdr 35 sekunder.

% Under uppstart blinkar indikatorlampan
Wi-Fi SETUP pa enhetens framsida
snabbt gront.

> Efter uppstart blinkar indikatorlampan
Wi-Fi SETUP langsamt grént om ingen
Wi-Fi-anslutning har konfigureras fér
DS3880WV.

Stdng av enheten genom att trycka pa
igen.



H H Innan du ansluter DS3880WV till
4 An SI Ut tl I I d Itt ditt Wi-Fi-nétverk kontrollerar du
Wi-Fi-natverk punlcterna nedan

Se till att Wi-Fi-routern &r pa och fungerar

fo r Ai rPlay som den ska.

2 Setill att DS3880W ir pa och att
uppstarten har slutforts (se ‘Sla pa/av
DS3880W' pa sidan 10).

3 (dentifiera typ av Wi-Fi-router (information
finns i Wi-Fi-routerns anvandarhandbok).

«
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Scenario 1:Ansluta till en
WPS-router

E Kommentar

* Innan du trycker pa nagon knapp pa DS3880W bér du
se till att DS3880WV har startat upp som det ska (se ‘Sla
pa/av DS3880W' pé sidan 10).

1 Tryck pa WPS-knappen pa din Wi-Fi-router.

For att ansluta DS3880WV till ditt befintliga Wi-
Fi-ndtverk maste du tillimpa din Wi-Fi-instalining
pa DS3880W.

Du kan gbra det pa tva sitt (beroende pa vilken
typ av Wi-Fi-router du anvander):
*  Automatiskt — om Wi-Fi-routern &r
WPS-aktiverad (Wi-Fi Protected
Setup) och stéder PBC (Push Button
Connection) (se ‘Scenario 1: Ansluta
till en WPS-router’ pa sidan 11)
*  Manuellt — om Wi-Fi-routern inte
stoder WPS (se ‘Scenario 2: Ansluta till
en icke-WPS-router' pa sidan 12)

Nér anslutningen har genomférts 2 Kort efter steg 1 trycker du pa Wi-Fi
kommer DS3880W ihdg dina Wi-Fi- SETUP pé baksidan av DS3880W.
instdllningar. Sedan kan du anvdnda L |ndikatorn Wi-Fi SETUP blinkar
AirPlay nar DS3880W dr pa och vaxelvis rétt, gult och gront.
automatiskt anslutet till ditt Wi-Fi-

> |nom 2 minuter slutar indikatorn WI-FI
SETUP att blinka och lyser med ett fast
gront sken tills enheten piper

natverk.

sV 11



L [DS3880W har anslutits till ditt Wi-Fi-
natverk.

£

* For vissa Wi-Fi- routrar maste du halla WPS-knappen
for Wi-Fi-anslutning intryckt eller aktivera WPS-
PBC-funktionen pa routerns konfigurationssidor. Mer
information finns i anvandarhandbockerna for de
specifika routrarna.

* Om indikatorn Wi-Fi SETUP pa DS3880W blinkar gult
har Wi-Fi-anslutningen misslyckats.Vanta i 2 minuter och
forsok igen. Om problemet kvarstar kan du forsdka att
konfigurera Wi-Fi-anslutningen manuellt (se ‘Scenario 2:
Ansluta till en icke-WPS-router’ pa sidan 12).

¢ Om Wi-Fi-anslutningen misslyckas igen haller du bade
+ och - pa ovansidan av DS3880W intryckta for att
aterstélla och férsoka igen.

Scenario 2:Ansluta till en
icke-WPS-router

E Kommentar

* Du kan éven folja instruktionerna nedan om du vill
ansluta DS3880WV till en WPS-router manuellt.

12 SV

For att ansluta DS3880WV till en Wi-Fi-router
manuellt maste du &ppna den inbyggda
konfigurationswebbsidan for DS3880WV for
att dndra de interna Wi-Fi-instdllningarna. Det
g6r du med hjélp av en Wi-Fi-aktiverad enhet
med webbldsare for tillfllig Wi-Fi-anslutning till
DS3880W. Den Wi-Fi-aktiverade enheten kan
vara en iPod touch/iPhone/iPad eller en Wi-Fi-
aktiverad dator/MAC.

Folj stegen nedan for anslutning av DS3880W
till en Wi-Fi-router utan WPS.

1 Skrivned instélliningarna for Wi-Fi-routern
for anvandning vid Wi-Fi-konfiguration av
DS3880W (se Ta fram instéllningarna for
din Wi-Fi-router’ pa sidan 12).

2 Stillin DS3880W pa laget Assisterad
Wi-Fi-konfiguration (se ‘Stéll in DS3880W
pa laget Assisterad Wi-Fi-konfiguration’ pa
sidan 13).

Y Ett nytt Wi-Fi-ndtverk som skapas av
DS3880WV visas med natverksnamnet
(SSID) Philips Fidelio AirPlay.

3 Anslut den Wi-Fi-aktiverade enheten
tillfalligt till det nya Wi-Fi-natverket som
skapats (se ‘Ansluta den Wi-Fi-aktiverade
enheten till det nyskapade Wi-Fi-ndtverket’
pa sidan 14).

4 Oppna den inbyggda webbsidan for
DS3880W med hjdlp av webbldsaren i din
Wi-Fi-aktiverade enhet (se ‘Oppna den
inbyggda webbsidan for DS3880W' pa
sidan 15).

5 Andra de interna Wi-Fi-instdllningarna for
DS3880W utifran instéllningarna du skrev
ned i steg 1 (se ‘Andra interna Wi-Fi-
instdllningar for DS3880W' pa sidan 16).

6  Aterstill den Wi-Fi-aktiverade enheten
till dina befintliga Wi-Fi-instéllningar (se
‘Aterstilla den Wi-Fi-aktiverade enheten till
dina befintliga Wi-Fi-instéllningar' pa sidan
17).



Ta fram installningarna for din Wi-Fi-
router

E Kommentar

* Ha alltid anvandarhandboken for din Wi-Fi-router till
hands, dér finns detaljerade instruktioner:

1 Anslut din Wi-Fi-aktiverade enhet till det
befintliga Wi-Fi-ndtverket.

2 Starta webblisaren (till exempel Apple
Safari eller Microsoft Internet Explorer) pa
din Wi-Fi-aktiverade enhet.

3 Oppna konfigurationssidan fér din Wi-Fi-
router.

4 Oppna fliken med Wi-Fi-instillningar
och skriv ner féljande information pa ett
papper:

(A) Nitverksnamn (SSID)

Wi-Fi-sdkerhetslage (vanligtvis WER
WPA eller WPA2)

(© Wi-Fi-lssenord (om Wi-Fi-sakerhet &r
aktiverad)

@ DHCP-lage (aktiverat eller avaktiverat)

@ Instéllningar for statisk IP-adress (om
DHCP-laget ar avaktiverat)

Stall in DS3880WV pa laget Assisterad
Wi-Fi-konfiguration

E Kommentar

* Innan du trycker pa nagon knapp pa DS3880W bér du
se till att DS3880WV har startat upp som det ska (se ‘Sla
pd/av DS3880W' pa sidan 10).

*  Hall Wi-Fi SETUP pa huvudenhetens
baksida intryckt i mer dn 5 sekunder.
5 |ndikatorn Wi-Fi SETUP blinkar
vaxelvis gront och gult.

Y Ett nytt Wi-Fi-ndtverk som skapas av
DS3880WV visas med natverksnamnet
(SSID) Philips Fidelio AirPlay.

5 Det kan ta upp till 45 sekunder att
skapa det hdr nya Wi-Fi-ndtverket.

E Kommentar

¢ Naér du har konfigurerat Wi-Fi for DS3880W manuellt
férsvinner ndtverket som skapats av DS3880W.

* Om du inte kommer at ldget Assisterad Wi-Fi-

konfiguration stanger du av DS3880W, startar om det

och férsoker igen efter uppstart.

Se till att det inte finns ndgra andra Philips AirPlay-

aktiverade enheter i liget Assisterad Wi-Fi-konfiguration

samtidigt. Om flera Wi-Fi-ndtverk skapas pa det har

sattet kan de stéra varandra.

Sv. 13
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Ansluta den Wi-Fi-aktiverade enheten
till det nyskapade Wi-Fi-natverket

Endast en Wi-Fi-aktiverad enhet kan ansluta till
det nya Wi-Fi-ndtverk som skapas av DS3880WV.
Undvik stérning fran andra Wi-Fi-enheter
genom att tillfdlligt avaktivera Wi-Fi-funktionen
pa dina andra Wi-Fi-enheter.

Alternativ 1: Anvand iPod touch/iPhone/iPad
1 Vilj Settings (Instédllningar) -> Wi-Fi pa din
iPod touch/iPhone/iPad.

Settings

K erightness

ﬁ Wallpaper

y General >

2 Vélj Philips Fidelio AirPlay i listan over
tillgdngliga ndtverk.

14 sV

Settings W]‘Fl Ne‘works

Philips Fidelio AirPlay

v Phlllp%llo_o\lr... T O

>

3 Vintatills Wi-Fi-anslutningen har upprdttats
pa din iPod touch/iPhone/iPad.
> = visas i det Ovre vdnstra hdrnet av
din iPod touch/iPhone/iPad.

Tips

¢ Om Philips Fidelio AirPlay inte stdr med i listan
forsoker du identifiera tillgdngliga Wi-Fi-natverk igen.

Anvanda en Wi-Fi-aktiverad PC/Mac

Kommentar

¢ | anvandarhandboken for din PC/Mac finns information
om hur du ansluter din PC/Mac till ett Wi-Fi-ndtverk.

* Under anslutningen till Wi-Fi-ndtverket ska du inte
ansluta nagon natverkskabel till din PC/Mac.

1 Oppna verktyget for Wi-Fi-konfiguration
eller kontrollpanelen pa din PC/Mac.

2 Identifiera tillgdngliga Wi-Fi-ndtverk.



Searchin for siveiess rbwmerks i range...

3 Valj Philips Fidelio AirPlay i listan &ver
tillgdngliga natverk.

2
e I —al
RE T —— will |
Relsted Tavks [lf‘l’! . i
o st s § Sacrty-sabed st PAS] wil]
p—rey [T ———— |
i hange the order of
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z
P Darge advarced

Uy SePmm————
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4 Vinta tills Wi-Fi-anslutningen har uppréttats
pa din PC/Mac.

(er} S—

«i:l s

et kit v, et will

(TI S
¢ Bonurky-enabied wesless reta. alll

(ﬁiu S, &l

Tips

* Om Philips Fidelio AirPlay inte star med i listan
forsoker du identifiera tillgéngliga Wi-Fi-ndtverk igen.

Oppna den inbyggda webbsidan for
DS3880W

1 Starta webblisaren Apple Safari eller
nagon annan webbldsare pa din Wi-Fi-
aktiverade enhet.

2 Ange 192.168.1.1 i webbldsarens adressfalt
och bekrifta.

> Konfigurationssidan for DS3880W
visas.

Welcome to Philips FidelR

slepsheimmtomnned

de\noe name dmnge
Philips Fidelio device name: Philos_Fidelio 2398FA

Please select your wireless network and enter
your network password if applicable. For
advanced network setup, please click
Advanced; Click Apply to connect your wireless

speaker to your network.
i Please select your Wi-Fi network: | Select Optin i
< 2 m O
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Om du anvinder Safari pa din Wi-Fi-aktiverade
PC/Mac kan du adven vilja “Philips_Fidelio
XXX fran listrutan Bonjour och ange
konfigurationssidan for DS3880WV direkt.

1 Kicka pa % -> Preferences (Instéllningar).
& Menyn Bokmdrken visas.

Ii_ a
Frilips Fidelio - =

el

e :-—-J wpano o pr
Custamize Toolbar

Hide Menu Bar

T e
Hide Bookmarks Bar ~ ChrlShift+8
Hide Tab Biar Ctrl+shift+T
Hide Status Bar Ciri+f
History Ctri+H |
Dowrloads Chri+alt+.

Private Erowsing.
Reset Safari
Block Pop-lp Windows  CrrbShift+

——
e
Help F1
Report Bugs to Apple.

Safari Extensions Gallery
About Safari

2 Markera Include Bonjour i
bokmarkesfaltet.

3 Vilj “Philips_Fidelio XXX fran listrutan
Bonjour i bokmérkesfdltet.
> Konfigurationssidan for DS3880W
visas.

Bomjour ¥ Apple  Yahoo!  Go |+ g

About Bonjour

Andra interna Wi-Fi-instillningar for
DS3880W

Pa konfigurationssidan fér DS3880W kan

du dndra de interna Wi-Fi- instdllningarna i
DS3880WV for anslutning av DS3880WV till ditt
befintliga Wi-Fi-ndtverk.

Kommentar

* Setill att instdllningarna pa konfigurationswebbsidan
Sverensstimmer med de Wi-Fi-instdllningar for
hemnétverket som du skrev ner pa papper.

182.168.1.1

[v]

Py Fidelo ‘
Welcome o Philips Fidelio setup page. Follow the
#lapa balow 1o connect your wirsless spaaker lo your
wirchess network

You can keep the default device name ar
modily the device name by modifying the taxt

in the text box, Click Agply to procesd with
device nama change.
Fhilips Fidelo devics nama; [Pl s 2164

ooy

Plaase selact your wirelass natwark and enter
your network password |f applicable. For
advanced network selup, please ciick
Advanced; Click Apply to connect your wireless
spaaker o your network,

Pioasn seloct your WieFi nptwork: | SesaOen |

4 = m O

*  Folj anvisningarna pa skarmen for att
dndra och bekriéfta de interna Wi-Fi-
instdllningarna f6r DS3880WV.
> Efter en stund slutar indikatorlampan

pa baksidan av DS3880WV att blinka
och lyser med ett fast gront sken, och
enheten piper.

L DS3880W ar nu ansluten till ditt
befintliga Wi-Fi-ndtverk.



E Kommentar

* Om indikatorlampan WI-FI SETUP pa DS3880W
inte lyser gront har Wi-Fi-anslutningen har misslyckats.
Stdng av bade Wi-Fi-routern och DS3880WV, starta om
dem och forsok ansluta DS3880W till Wi-Fi-ndtverket.
Om problemet kvarstar férsoker du med ovanstdende
procedur igen.

¢ Nar du har slutfért dndringarna ovan eller startat om
DS3880W kommer det Wi-Fi-ndtverk som skapades av
DS3880W att forsvinna.

5

¢ Om du vill kan du dndra namnet fér din DS3880W
under Advanced settings -> AirPlay Device Name
(Avancerade instéliningar -> Airplay-enhetsnamn) pa
konfigurationssidan fér DS3880W. Det &r bra att gora
om du har manga Philips AirPlay-enheter i hemmet och
behdver kunna skilja dem at.

* Om du vill ange nitverksnamnet (SSID) manueltt
(till exempel om du vill délja ditt SSID) gar du till
Advanced settings -> CONFIGURE MANUALLY
(Avancerade instéliningar -> Konfigurera manuellt) pa
konfigurationswebbsidan for DS3880W.

Aterstilla den Wi-Fi-aktiverade
enheten till dina befintliga Wi-Fi-
installningar

Kommentar

* Se till att instéllningarna i steg 2 till 3 nedan
Sverensstimmer med de Wi-Fi-instéllningar for
hemnétverket du skrev ner pa papper.

1 Vil Settings (Installningar) -> Wi-Fi pa din
iPod touch/iPhone/iPad.
*  Du kan dven 6ppna listan med
tillgdngliga Wi-Fi-ndtverk pa din PC/
Mac.

Settings

K3 Brightness

ﬁ Wallpaper

2 Vdlj ditt natverksnamn (SSID) fran listan
med tillgdngliga tradldsa natverk.

sertings  Wi-Fi Networks

Ask to Join Networks [Wel/l

3 Ange ndtverksnyckeln om sa behdvs.

4 Vinta tills Wi-Fi-anslutningen till ditt Wi-Fi-
ndtverk har upprattats.

Ssv. 17
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5 Uppspelning

Stromma ljud fran iTunes-
musikbiblioteket till
DS3880W

E Kommentar

¢ Se till att din iTunes-védrdenhet dr ansluten till samma
Wi-Fi-ndtverk som DS3880W. iTunes-enheten kan vara
en iPod touch/iPhone/iPad med iOS 4.3 (eller senare)
eller en PC/Mac med Wi-Fi-funktioner och iTunes 10
(eller senare).

Stromma fran iPod touch/iPhone/iPad

1 starta iPod-programmet pa din iPod
touch/iPhone/iPad.

2 Tryck pa AirPlay-ikonen.

« ) "'Symphon'y No. Q'lchherzo.}' )

3 Vélj Philips_Fidelio XXXX (eller det namn
du har angett) fran AirPlay-listan.

Cancel

4 Vilj en mediefil och bérja spela upp.
L Efter en stund hérs musik fran
DS3880WV.

s Symphony No. 9 (Scherzo)

¢ |1 Wl

A———

Kommentar

* Om du inte kan héra musik efter slutférd konfiguration
kan du gora nagot av foljande pé iPod touch/iPhone/
iPad:

* (1) Koppla fran och ateranslut till samma Wi-Fi-router
igen;

* (2) Stang alla program som kors i bakgrunden;

* (3) Stdng av och starta om iPod touch/iPhone/iPad.




Stromma fran PC/Mac

1 StartaiTunes 10 (eller en senare version)
pa din PC/Mac.

2 Kicka pa AirPlay-ikonen i fonstret.

i 1

fii

=T

3 Valj Philips_Fidelio_AirPlay XXXX (eller
det namn du har angett) fran AirPlay-listan.

Mtiple Speakers..

4 Vilj en mediefil och bérja spela upp.
L Efter en stund hors musik fran
DS3880WV.

Tips

* Nar du strémmar ljud fran iTunes-musikbiblioteket pa
en PC/Mac kan du vdlja fler @n en AirPlay-aktiverad
enhet (om du har fler) i steg 3 och strémma musik till
dem alla samtidigt.

¢ Om en tidigare version av iTunes anvdnds kanske
ikonen for AirPlay ar € istdllet for [al.

Kontrollera uppspelning

Du kan vilja olika uppspelningsalternativ pa
iTunes-vardenheten eller DS3880W.

Kommentar

¢ Setill att du strémmar ljud fran iTunes-musikbiblioteket
till DS3880WV.

*  Tryck pa > Il om du vill pausa eller
ateruppta uppspelningen.

o Tryck pa + /- flera ganger for att justera
volymen.

Tips

* Om du strémmar musik fran en PC/Mac for att styra
musikuppspelningen fran DS3880W, ska du kryssa i
Allow iTunes audio control from remote speakers
(Tillat iTunes ljudkontroll fran fiirrhégtalare) i Edit ->
Preferences -> Devices (Redigera -> Instéllningar ->
Enheter) pa iTunes.

[

Anvanda avancerade
ljudinstallningar

Om din iTunes-vardenhet ar en iPod touch/
iPhone/iPad:

For avancerade ljudinstéllningar och
tilldggsfunktioner kan du anvanda din iPod
touch/iPhone/iPad och ladda ned programmet
Philips Fidelio fran Apple App Store. Det ar ett
kostnadsfritt program fran Philips.

SV 19
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Om din iTunes-vardenhet ar en Wi-Fi-
aktiverad PC/Mac:

For avancerade ljudinstéliningar kan du anvdnda
equalizern som finns i iTunes direkt (View ->
Show Equalizer, (Visa -> Visa equalizer).

5

¢ Mer information finns i hjdlpen for iTunes.

Spela upp/ladda din iPod/
iPhone/iPad via USB-uttaget

E Kommentar

* USB-uttaget dr endast kompatibelt med iPod/iPhone/
iPad.

¢ For att undvika att DS3880W skadas bor du aldrig
forsoka ansluta andra enheter dn iPod/iPhone/iPad till
USB-uttaget pa DS3880W.

Du kan spela upp filer fran eller ladda din iPod/
iPhone/iPad via USB-uttaget med hjélp av en
USB-kabel (medféljer inte).

Om du har stoppat ljudstrémning med AirPlay
vaxlar enheten automatiskt till USB-kélla nar
USB-anslutning har upprittats.

20 sV

*  Anslut en Apple USB-kabel (medféljer

inte) till:

*  USB-uttaget *<5 pa baksidan av
DS3880WV.

*  dockningskontakten pa iPod/iPhone/
iPad.

5

* Tack vare det inbyggda batteriet i DS3880W kan du
spela upp filer pa iPod/iPhone/iPad nér du &r pa sprang.

¢ Det inbyggda batteriet stéder inte laddning av iPod/
iPhone/iPad.

Kompatibel iPod/iPhone/iPad

Du kan spela upp musik och ladda féljande
modeller av iPod, iPhone och iPad via USB-

uttaget.

e jPad2

e iPad

e iPhone 4

e  iPhone 3GS

*  iPhone 3G

*  iPhone

*  iPod classic

e Pod 5G

e Pod 4G

* iPod nano (23, 3¢, 4, S, 6
generationen)

*  iPodtouch (1:a, 2:a, 3:e, 4:e generationen)

Spela upp fran en extern
enhet

Du kan dven lyssna pa en extern ljudspelare via
DS3880W.

Om du har stoppat bade ljudstrémning med
AirPlay och direkt musikuppspelning via USB-
uttaget vaxlar DS3880WV till MP3 link-klla
automatiskt.



Anslut den medféljande MP3 link-kabeln
till:
*  MP3-LINK-uttaget pa baksidan av

DS3880W.
*  horlursuttaget pa en extern
judspelare.

N%
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6 Uppdatera fast
programvara

Philips kan komma att erbjuda uppgraderad
fast programvara f6r DS3880WV sd att din
DS3880WV fungerar bittre.

Om du registrerar din produkt pa www.philips.
com/welcome far du information om den
senaste fasta programvaran.

Kommentar

* Du kan bara uppdatera den fasta programvaran fran
en PC/Mac.

Ladda ned uppdateringsfilen

"Q

Q :;E United Kingdom / English
Register your product / Legin | XXX =3

]
-]

|
©| i o0 zp

1 Gatil www.philips.com/support pa din PC/
Mac.

2 Ange modellnumret for att hitta den
senaste tillgdngliga uppgraderingsfilen for
fast programvara.

3 Spara uppgraderingsfilen pa harddisken.

22 SV

Uppdatera fran
konfigurationssidan

1N Varning

* Anslut alftid din DS3880W till natstrém for
uppgradering av fast programvara. Stang aldrig av din
DS3880W under uppgradering av fast programvara.

Kommentar

¢ Kom ihag att ga till konfigurationssidan for Wi-Fi-
routern och skriva ned IP-adressen fér din DS3880W
om du vill anvdnda en annan webbldsare dn Apple
Safari pa din PC/MAC. Information om hur du hittar
|P-adresserna for de enheter som &r anslutna till Wi-Fi-
routern finns i routerns anvandarhandbok.

1 sa pa DS3880WV (se ‘Innan du bérjar’ pa
sidan 10).
> Det tar cirka 35 sekunder innan
enheten startar Under uppstart
blinkar indikatorn WI-FI SETUP pa
huvudenhetens framsida snabbt gront.

> Efter uppstart hors ett pip och
indikatorn WI-FI SETUP bérjar lysa
med ett fast gront sken. DS3880W
ansluter automatiskt till det senast
konfigurerade Wi-Fi-nétverket.

2 Setill att DS3880W och din PC/MAC ar
anslutna till samma Wi-Fi-router.

3 Oppna Apple Safari pa din PC/Mac och
vdlj sedan Philips_Fidelio XXX'i den
nedrullningsbara listan fér Bonjour.

*  Eller 6ppna en annan webbldsare
pa din PC/MAC och skriv sedan in
IP-adressen for DS3880WV (finns pa
konfigurationssidan fér Wi-Fi-routern)
i adressraden.
> Konfigurationswebbsidan for
DS3880WV visas.



G

4 Sitfor uppdateringen av fast programvara

genom att folja instruktionerna pa skarmen.

E Kommentar

* Om uppdateringen av den fasta programvaran
misslyckas kan du férsoka utfora atgérden ovan igen.

¢ Om problem uppstar med Wi-Fi-anslutningen efter
uppdateringen av den fasta programvaran haller
du bade + och - pa DS3880W intryckt i mer dn 5
sekunder samtidigt for att aterstélla enheten, och
forsoker sedan konfigurera Wi-Fi-ndtverket for
DS3880W igen.

SV
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/ Produktinforma-

Allman information

. Nétstrom Ingang: 100 - 240 V~,
tion S0/60 Hz 1AM 2 A
Utgang: 12V =30A
Effektforbrukning vid 3B5W
Kommentar anvindning
Stromférbrukning i <05W
¢ Produktinformationen kan komma att dndras utan standbylége
féregdende meddelande. Storlek
- Huvudenhet (Lx B 198 x 100 x 215 mm
x H)
Vikt
Specifikationer - Med férpackning 1,95 kg
- Huvudenhet 1,32 kg
Forstarkare
Nominell uteffekt 4 x4 Wrms
Frekvensomfang 63 - 20 kHz
Signal/brusforhdllande > 75 dB
MP3 Link 650 mV RMS 20 kohm
Hogtalare
Hogtalarimpedans 8 ohm
Hogtalarelement 40 mm fullt
frekvensomfang
Kanslighet 78 dB/m/W
Tradlost
Trad|os 802.11b/g
standard

Tradlos sakerhet WEP (64- eller 128-bitars),
WPA/WPA?2 (8-63 tecken)

Frekvensomfang 2 412 - 2 462 MHz (CH1-
CH11) (for /179,137,1/55,197)
2412 - 2472 MHz (CH1-
CH13) (for /12,/10,/05)

PBC (en Ja

knapptryckning)
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8 Felsokning

'!‘ Varning

* Ta aldrig bort hdljet fran apparaten.

Forsok aldrig reparera systemet sjalv. Om du
gor det géller inte garantin.

Om det uppstar problem vid anvandningen av
apparaten bor du kontrollera nedanstaende
punkter innan du begir service. Om problemet
kvarstar gar du till Philips webbplats (www.
philips.com/welcome). Nér du kontaktar Philips
bér du ha bade apparaten samt modell- och
serienumret till hands.

Ingen strom

e Se till att enhetens natkontakt ar korrekt
ansluten.

*  Setill att det finns strém i ndtuttaget.

e Innan du anvander DS3880WV néar du ar
pa sprang bor du se till att det inbyggda
batteriet ar fulladdat.

Inget ljud.

e Justera volymen.

*  Kontrollera Wi-Fi-ndtverksanslutningen.
Konfigurera ndtverket igen om sa kravs.

Inget svar fran enheten

*  Hall bdde + och - pa DS3880W intryckta
i mer dn 5 sekunder for att aterstalla
enheten. Konfigurera sedan Wi-Fi-ndtverket
for DS3880WV igen.

*  Koppla fran och dteranslut ndtkontakten
och sld sedan pa enheten igen.

Wi-Fi-natverksanslutning misslyckades

*  Kontrollera om Wi-Fi-routern dr Wi-Fi
802.11b/g-certifierad. Den hdr enheten &r
endast kompatibel med Wi-Fi 802.11b/g-
certifierade routrar.

* Om Wi-Fi-routern ar Wi-Fi
802.11n-certifierad aktiverar du 802.11b/g-
ldget. DS3880WV stdder inte anslutning till
routrar med endast 802.11n.

*  Den hir enheten stoder inte WPS-PIN-
metoden.

*  Om Wi-Fi-routern stéder WPS- och WPS-
PBC-metoderna men inte kan ansluta
till DS3880W kan du férsdka med den
manuella Wi-Fi-konfigurationsmetoden (se
‘Scenario 2: Ansluta till en icke-WPS-router’
pa sidan 12).

*  Aktivera SSID-sdandning pa WiFi-routern.

*  Hall borta fran potentiella stérningskallor
som kan paverka Wi-Fi-signalen, till
exempel mikrovagsugnar.

e Om du inte kan anvdnda din PC for Wi-Fi-
konfigurationen kontrollerar du om PCin
anvander ett Wi-Fi-ndtverk. Du kan inte
anvdnda Ethernet-anslutning for AirPlay-
ndtverkskonfiguration.

*  Setill att hemrouterns SSID-namn bestar
av alfanumeriska tecken, utan infogade
mellanslag eller specialtecken som %/#/*.

*  Om du vdljer att byta namn pa AirPlay-
enheten Philips_Fidelio XXXX i
instéllningsmenyn ska du inte anvdnda
nagra specialtecken eller symboler.

*  Forvissa nya typer av Wi-Fi-routrar kan ett
ndtverksnamn (SSID) skapas automatiskt
nar du ansluter med hjilp av WPS. Andra
alitid standardndtverksnamnet (SSID) till ett
enkelt sadant bestaende av alfanumeriska
tecken och dndra Wi-Fi-sakerhetsldget for
att skydda natverket.

«
X~
2
c
[
>
(7]

Tillfalliga avbrott i AirPlay-musikstromning

Anvand ett eller flera av féljande alternativ:

e Flytta DS3880W ndrmare Wi-Fi-routern.

* Tabort eventuella hinder mellan
DS3880W och Wi-Fi-routern.

*  Undvik att anvdnda Wi-Fi-kanal som
Sverlappas av det narbeldgna Wi-Fi-ndtverket.

*  Kontrollera om nétverkshastigheten dr
tillrdckligt snabb (i fall dar flera enheter
delar samma router kan AirPlay-kapaciteten
paverkas). Stang av de andra enheterna
som dr anslutna till din hemrouter.

e Aktivera Quality of Service-alternativet
(QoS) (om tillgdngligt pa Wi-Fi-routern).

*  Sting av andra Wi-Fi-routrar.
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Det visas ingen AirPlay-ikon pa min iTunes-

vardenhet

*  Setill att DS3880WV redan dr ansluten till
ditt Wi-Fi-ndtverk.

*  Innan du &ppnar iTunes kontrollerar du att
du har aktiverat Bonjour-tjansten i datorn.
Exempelvis Windows XP: aktivera tjansten
genom att klicka pa Start -> Control
Panel (Kontrollpanelen), dubbelklicka
pa Administrative Tools -> Services ->
Bonjour Service (Administrativa verktyg
->Tjanster -> Bonjour Service) och klicka
sedan pa Start och OK i fonstret som
oppnas.

e Om problemet kvarstar kan du férscka
starta om DS3880W.

AirPlay-anslutning misslyckades med Mac eller

PC

*  Avaktivera tillfilligt brandvagg och
sakerhetsprogram och kontrollera om de
spdrrar portarna som AirPlay anvander for
strédmning. Instruktioner fér hur du dppnar
portarna som anvands av AirPlay finns i
dokumentationen till brandvdggen och dina
sdkerhetsprogram.

*  Om musikuppspelningen kraschar eller
stannar ndr du anvander iPod Touch/
iPhone/iPad/Mac/PC f6r AirPlay provar du
att starta om din iPod Touch/iPhone/iPad,
iTunes eller DS3880WV.

*  Videostromning och FTP-hdmtningar kan
Overbelasta routern och darfér orsaka
avbrott under AirPlay-musikuppspelning.
Forsok att minska belastningen pa routern.

Observera! Stombrytaren ar sekundart
kopplad och bryter inte strémmen fran natet.
Den inbyggda natdelen ar darfor ansluten

till elnitet sa linge stickproppen sitter i
vagguttaget.
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